2012
TAMC PASER
Training Manual

Manual Prepared by:
The Center for Technology & Training (CTT)
Michigan Technological University

Revised: May 2012
Table of Contents

Introduction ............................................................................................................................ 1
 Michigan’s Regional Planning Organizations ................................................................. 2
 Michigan’s Metropolitan Planning Organizations ......................................................... 3
 Section 1: Data Collection Requirements .............................................................................. 4
 PASER Data Collection Regulations ................................................................................. 4
   Roads that Must be Rated .............................................................................................. 4
   New Definition of “Federal Aid Eligible” ................................................................. 4
   Collection Timeline ........................................................................................................ 5
   Rating Teams ................................................................................................................. 5
   Required Training Sessions ....................................................................................... 5
   Reimbursement .............................................................................................................. 5
   Quality Control .............................................................................................................. 6
 Rating Roads Effectively ................................................................................................... 6
   Rating Speed ................................................................................................................ 6
   Rate Distress—Not Ride Quality .................................................................................. 6
   Measuring Rutting ........................................................................................................ 6
   Group Dynamics ............................................................................................................ 6
   Lighting Conditions ....................................................................................................... 6
   Inclement Weather ....................................................................................................... 6
   Boundary Segments ..................................................................................................... 7
 Data Management .............................................................................................................. 7
   Data Collection Starts at The Local Agency ............................................................... 7
   Working with Smaller Cities and Villages ................................................................. 7
   Splitting Segments ....................................................................................................... 7
   Errors in the Framework Map ...................................................................................... 7
 Safety Concerns ................................................................................................................ 8
   General Safety ............................................................................................................. 8
   Seating within the Vehicle ......................................................................................... 8
   Replacement Vehicles ............................................................................................... 8
   Emergency Plan .......................................................................................................... 8
   Computer Hardware .................................................................................................. 8
 Section 2: Data Collection Procedure .................................................................................. 9
Introduction

The Pavement Surface Evaluation and Rating (PASER) system is a visual survey method for evaluating the condition of roads. The method was developed by the University of Wisconsin Transportation Information Center to provide a simple, efficient, and consistent method for evaluating road condition. Michigan’s Transportation Asset Management Council (TAMC) has adopted the PASER system for measuring state-wide pavement conditions in Michigan.

Part of the TAMC’s mission is to obtain accurate PASER ratings which provide a clear view of the condition of the road network in Michigan. The TAMC uses these ratings to communicate to the Michigan Legislature the condition of Michigan roads. At the local level, this data serves as the foundation on which to build cost-effective pavement maintenance strategies.

The TAMC chose RoadSoft—a roadway management system for collecting, storing and analyzing data—for use in developing its state-wide pavement rating collection strategy. RoadSoft is funded through the Michigan Department of Transportation (MDOT) and developed, supported, and distributed by Michigan Technological University’s Center for Technology & Training (CTT).

The TAMC also works in conjunction with Michigan’s Regional/Metropolitan Planning Organizations (RPO/MPO) to collect PASER data. Although these regional organizations operate under many different names and serve a variety of different areas, they all participate in coordinating and performing PASER data collection.

This manual describes the requirements and processes involved in collecting PASER data for the TAMC in conjunction with the RPO/MPOs. It also includes information on how to split segments, rate sealcoats, and double-check collected PASER ratings in RoadSoft.
Michigan’s Regional Planning Organizations

Map Legend
1. Southeast Michigan Council of Governments
2. Region 2 Planning Commission
3. Southcentral Michigan Planning Council
4. Southwestern Michigan Commission
5. GLS Region V Planning Commission
6. Tri-County Regional Planning Commission
7. East Central Michigan Planning & Development Region
8. West Michigan Regional Planning Commission
10. Northwest Michigan Council of Governments
11. Eastern Upper Peninsula Regional Planning and Development Commission
12. Central Upper Peninsula Regional Planning and Development Commission
13. Western Upper Peninsula Planning and Development Regional Commission
14. West Michigan Shoreline Regional Development Commission
Michigan’s Metropolitan Planning Organizations
Section 1: Data Collection Requirements

PASER Data Collection Regulations

According to Act 51 (P.A. 499 2002, P.A. 199 2007) each local road agency shall annually report the mileage and condition of the road and bridge system under their jurisdiction to the TAMC. To fulfill the requirement of this Act each year the TAMC sets requirements for road condition data collection and submission by road owning agencies in Michigan.

Road condition rating is eligible for reimbursement from the TAMC if the required training is attended and proper documentation is submitted at the end of the collection process.

Roads that Must be Rated

At least 50% of federal-aid eligible, paved roads must be rated. Data from unpaved roads should not be submitted. There are three categories of data required for each rated road:

1. Surface Type
2. PASER Rating
3. Number of Lanes

New Definition of “Federal Aid Eligible”

For the TAMC PASER data collection there has been change in what constitutes a “federal-aid eligible” road. This change excludes some Rural Minor Collectors that that were rated during previous years.

According to 23 USC § 101, “federal-aid eligible” roads are “highways on the Federal-aid highway systems and all other public roads not classified as local roads or rural minor collectors.” This definition can be stated in terms of NFC class, where NFC = 1, NFC = 2, NFC = 3, NFC = 4, NFC = 5, and NFC = 6 where one or both sides of the road on or in an urban boundary (RU_L > 1 or RU_R > 1). NFC codes are defined as follows:

1 – Interstates
2 – Other Freeways
3 – Other Principal Arterials
4 – Minor Arterials
5 – Major Collectors
6 – Minor Collectors
7 – Local
0 or uncoded – not a certified public road

RU_L | 1 Rural/Urbans designation left
RU_R | 1 Rural/Urbans designation right

1 – Rural area
2 – Small urban area (5,000 to 49,000)
3 – Small urbanized area (50,000 to 199,999)
4 – Large urbanized area (200,000 or more)
For paved federal-aid data collection the council collects PASER data based on the above definition of “Federal-aid eligible”, so you will not be collecting PASER data on Rural Minor Collectors. Using the current RoadSoft query of “Federal Aid = True” will take this change into account and give you the correct network conforming to the new definition.

**Collection Timeline**

Data collection begins: April 2, 2012  
Data collection completed by: November 30, 2012  
Data submitted to the Center for Shared Solutions (CSS) by: December 7, 2012

**Rating Teams**

Teams should be comprised of one member from MDOT, one member from the Act-51 jurisdiction’s Regional/Metropolitan Planning Organization and one member from the jurisdiction being rated (County, City, or Village).

To schedule your PASER data collection, contact your RPO or MPO. See the maps on pages two and three to determine the regional planning office that your jurisdiction falls under. See [http://miregions.com/michigan-planning-regions/](http://miregions.com/michigan-planning-regions/) if you need contact information for an RPO or MPO.

**Required Training Sessions**

Anyone who participates in PASER data collection on the federal-aid road system and expects to be reimbursed for their time MUST attend PASER training in the same year the data collection is to occur. New raters and raters who have not participated in rating for a year or more MUST attend one supplemental PASER webinar training session in addition to the classroom session.

The TAMC has instituted a testing and certification program for PASER data collectors who attended TAMC PASER training and collected PASER data for multiple years. The certification allows experienced raters to opt out of training in future years. To become certified, qualified raters must pass an exam which will be administered after the on-site PASER training sessions. Raters seeking certification must attend an on-site PASER training during 2012.

**Reimbursement**

According to the TAMC, “Anyone who intends to participate in the TAMC PASER condition data collection on either the federal aid or non-federal aid system, and expects to be reimbursed by the TAMC for their effort, must attend the Classroom Training Session.” “New raters, or others that did not actively rate in the last two years, must also attend the PASER Webinar Training.” Collection teams must also complete a Time Expense Log provided by their RPO to be eligible for reimbursement by the TAMC (see Appendix A for an example).

Invoices for rating efforts should be submitted through your RPO/ MPO to:

Brian Sanada  
Michigan Department of Transportation  
PO Box 30050  
425 W. Ottawa St.  
Lansing, MI 48909  
[Sanadab@michigan.gov](mailto:Sanadab@michigan.gov)
Quality Control

The RPO Coordinator must review the collected data before sending it to the CSS. This quality control procedure is described in detail in Section 5.

Rating Roads Effectively

Rating Speed

Rating roads at high speeds can cause inaccuracy. Reviews conducted by Michigan Tech PASER trainers have shown that teams that view roadways at lower speeds are much more likely to rate them accurately. Rating roads at high speed can cause distresses to be missed and result in higher than appropriate ratings.

Rate Distress—Not Ride Quality

Just because a road rides well doesn’t mean that it doesn’t have distress in need of Capital Preventative Maintenance (CPM) or Structural Improvement (SI). This is especially true on a road with rutting and cracking in the wheel path, both of which can cause rapid deterioration.

Conversely, an asphalt surface in relatively good condition, with sealed longitudinal cracks, often makes quite a bit of noise as tires pass over the expanded crack seal. More noise does not always mean severe distress. Don’t let ride quality distort your ratings.

Measuring Rutting

It can be difficult to detect rutting when moving at high speeds on a sunny day. To help avoid incorrect rutting assessments, each regional office is provided with a 6-foot aluminum T-bar. By using the bar in conjunction with a tape measure, teams can quickly get a tangible assessment of the extent of rutting on a road where it is practical and safe to do so.

Group Dynamics

Teams need to be aware of group dynamics in their vehicles. Condition rating is supposed to be a group process. However, the process also needs to conform to PASER procedure. Teams should read the PASER descriptions closely and refer to the laminated reference sheets for clarification.

Lighting Conditions

Changes in lighting conditions and the time of day can influence how some distresses are perceived. Bright sunlight directly overhead may make surface texture defects or fine cracking hard to discern. Rating early in the morning or late in the afternoon on a sunny day while driving into the sun may also make it difficult to rate roads effectively. If lighting conditions are poor, slow down or stop to make sure that you are not overlooking any visual cues.

Inclement Weather

PASER is a visual assessment system. Trying to rate pavement in the rain is ineffective. Road surfaces look different when they are wet—cracks look larger, puddles can hide distresses, etc. Teams should not rate roads on rainy days.
**Boundary Segments**

Boundary roads (roads that fall between jurisdictions) often have non-standard characteristics and splits on the RoadSoft map. As a result, it may be unclear which jurisdiction is responsible for rating a boundary road.

To eliminate potential data collection issues when rating boundary roads, follow these two rules:

**Rule 1: Follow the Collection Procedure (Section 2) carefully**

The steps for collecting and submitting TAMC data are laid out in a specific order to prevent rated roads from being overwritten by unrated roads. If you deviate from the documented procedure, some of your rating data may be overwritten by unrated roads.

**Rule 2: Rate ALL boundary roads in your network**

Rating teams should rate all boundary roads in their data collection networks, regardless of ownership or maintenance responsibilities.

**Data Management**

**Data Collection Starts at The Local Agency**

The data collection process needs to start with the local agency’s RoadSoft data set, not with an RPO or MPO’s version of RoadSoft. Collection teams should use local data as a starting point—NOT regional data.

**Working with Smaller Cities and Villages**

Smaller cities and villages are often enthusiastic about the data collection process. However, it can be time-consuming to visit smaller communities in order to set up a RoadSoft network. If an agency has a limited number of miles in their jurisdiction, it may be more efficient to provide them with a report (PASER Rating by PR Segment) and have them manually enter data in their version of RoadSoft. This allows data collectors to use the collection networks they build at their Road Commission without having to stop and upload data for these small agencies. Data collection should be dealt with on a case-by-case basis.

**Splitting Segments**

If a team encounters an undocumented change in the surface type or layout of a road (such as number of lanes) they should create a split in the RoadSoft map to reflect the change. Detailed guidelines for creating splits can be found in **Section 4**.

**Errors in the Framework Map**

If a team suspects that they have discovered an error in their jurisdiction’s map, they should first place a short notation in the Laptop Data Collector (LDC) memo field for that segment. Consistent use of a tag such as “error” can simplify creating a RoadSoft report containing these errors and the segments that they are located on. This information can be passed on to the CSS for correction.
Next, a team should fill out the Asset Management Change Request for Michigan Geographic Framework (Appendix B) and submit it to:

Joshua L. Ross  
Michigan Center for Shared Solutions  
Romney Building, 10th Floor  
111 S. Capital Ave.  
Lansing, MI 48033

You can also request changes by contacting Mr. Ross via phone at (517) 373-7910.

Safety Concerns

General Safety
During data collection, you will be merging in and out of traffic, slowing down, pulling off to the shoulder for team discussions, etc.—always take safety precautions. Driving the team vehicle is not something to be taken lightly. All the vehicles must be equipped with a warning light bar. Warning garments should be worn by raters that get out of the vehicle to better view distress or measure rutting. Above all, be sure to comply with your employer’s warning garment requirements.

Seating within the Vehicle
The best configuration for a 3-person team is the driver and rater in the front seats, and the data entry person in the back seat. If the data entry person sits in the front seat with a laptop, they could be injured by an airbag discharge.

Replacement Vehicles
If you need another vehicle, either use one from the county road commission or rent one. If you need to rent a vehicle, the MDOT rater should sign the rental agreement AND purchase the extra insurance; this will place everyone under the State’s insurance program.

Emergency Plan
Discuss ahead of time what you plan to do in case of an emergency—have an actual conversation! Have a cellular phone in each car and a number to call besides 911 if there is an issue.

Computer Hardware
Data collection teams are provided a laptop computer and a GPS by their RPO/MPO, but it is best to have a second laptop in the vehicle just in case something goes wrong. Many county road commissions and cities now have laptop computers; consider using them as backup.
Section 2: Data Collection Procedure

Before you begin collecting road data for the TAMC, ensure you are using RoadSoft and Laptop Data Collector Version 7.4 for the 2012 data collection season (released April 2012).

Visit www.roadsoft.org/releases/Latest_RoadSoft_Release for RoadSoft updates.

If you have any questions or concerns, please call RoadSoft support at 906-487-2102.
Step 1: Identify your TAMC network for data collection

Make sure you are using the local agency’s copy of RoadSoft at the Road Commission, City, or Village for which you will be collecting data.

The decision of how to develop a TAMC network is being left up to agencies and Regional Coordinators. Remember that networks must include at least 50% of all paved, federal-aid eligible roads that were not collected in the previous year.

There are three scenarios that an agency may encounter when creating a PASER rating network:

- Agencies that have saved their TAMC network data from the last rating year. (See Scenario 1, below)
- Agencies that have rating data from the last year but did not save their rating network. (See Scenario 2, on the next page)
- Agencies that rated 100% of their federal-aid network the previous year or don’t have a TAMC network recorded.

Scenario 1: Agencies that saved their TAMC network from the last rating year

You can load and verify a TAMC network from the previous year and use it to create a new one.

a. Open the Network/Filter Builder window by either right-clicking on the map and selecting Network/Filter Builder, or by clicking on the map toolbar’s Filter button and selecting Network/Filter Builder.

b. In the Network/Filter Builder window, click the Open button to open the Select Network/Filter window.

c. Select your saved TAMC network and click the OK button.

d. The criteria for the network are displayed. Verify that the filters are correct and then click the Clear Criteria button.

e. Create a new TAMC network using the Network/Filter Builder. Select all of the roads that were not rated in the previous year by adding criteria. Select a Field, Operator and Value to define criteria. For the first criterion, select Saved Networks/Filters as the Field, Not Equal To (<> ) as the Operator, and your TAMC network from last year as the Value, and then click the Add Criteria button.

f. Add another criterion with Federal Aid as the Field, Equals as the Operator, and True as the Value.
g. Add a final criterion with **Surface Type** as the Field, **Equals** as the Operator, and **Asphalt, Seal Coat, Concrete, and Brick** as the Values. Your Network/Filter Builder should now look similar to the image below.

**NOTE:** To select multiple values at the same time, hold down the control key while clicking.

![Network/Filter Builder](image)

h. Click the **Save** button to save your network.

i. Enter a name for your network and then click the **OK** button.

**TIP:** Using a descriptive file name and adding a date to it can help you find the network later and ensure that you export the correct one.

![Save Network/Filter](image)

j. Click **OK** to close the notice showing that your TAMC network was successfully saved.

k. Exit the **Network/Filter Builder** by clicking the close button.

l. Proceed to **Step 2.**
Scenario 2: Agencies that have rating data from the previous year, but did not save their TAMC network

You will need to re-create your TAMC network by defining the dates during which your agency collected TAMC ratings last year.

a. Open the Network/Filter Builder window by right-clicking on the map and selecting Network/Filter Builder.

b. Recreate your previous TAMC network using the Network/Filter Builder. Select the range of dates during which your agency rated roads during the previous year by adding criteria. Select a Field, Operator and Value to define criteria. For the first criterion select *Eval Date* as the Field, *Greater than or Equal to* as the Operator, and the *Date* when your agency started collecting TAMC ratings during the previous year as the Value. Then, click the Add Criteria button.

c. Add another criterion with *Eval Date* as the Field, *Less than or Equal to* as the Operator, and the *Date* your agency finished collecting TAMC ratings during the previous year as the Value.

d. Add another criterion with *Federal Aid* as the Field, *Equals* as the Operator, and *True* as the Value.

e. Add a final criterion with *Surface Type* as the Field, *Equals* as the Operator, and *Asphalt, Seal Coat, Concrete* and *Brick* as the Value. Your Network/Filter Builder should now look similar to the image below.

f. Click the Save button to save your network.
g. Enter a name for the network and then click the **OK** button.

![Save Network/Filter](image)

**h. Click OK to close the notice showing that your old TACM network was successfully saved.**

i. Create a new TACM network using the re-created network as a filter. Select **Saved Networks/Filters** as the Field, **Not Equal To (<>)** as the Operator, and your re-created **TACM network** from last year as the Value, and then click the **Add Criteria** button.

j. Add another criterion with **Federal Aid** as the Field, **Equals** as the Operator, and **True** as the Value.

k. Add a final criterion with **Surface Type** as the Field, **Equals** as the Operator, and **Asphalt, Seal Coat, Concrete** and **Brick** as the Value. Network/Filter Builder should now look similar to the image below.

![Network/Filter Builder](image)

**l. Save your TAMC network. Click the **Save** button located in the top left of the Network/Filter Builder window. Enter a name for your network and then click the **OK** button.**
TIP: Using a descriptive file name and adding a date to it can help you find the network later and ensure that you export the correct one.

Save Network/Filter dialog box

m. Click OK to close the notice showing that your old TAMC network was successfully saved.

n. Exit the Network/Filter Builder by clicking the close button.

o. Proceed to Step 2.

Scenario 3: Agencies that Rated 100% of their Federal-Aid Network the Previous Year

Even if your agency rated 100% of your paved federal-aid roads last year, you are still required to rate at least 50% of those roads this year.

Step 2: Export the TAMC network for use with the Laptop Data Collector

a. Open the TAMC menu from the RoadSoft menu bar. Select 1 - (County/City Does This) Export Data for LDC.

b. Click on Choose Network, then click on Edit. Select your TAMC network from the drop down list. The network you want is the one you saved at the end of your appropriate scenario in Step 1.

c. Define an Export Path; this is the location on your hard drive where you want to save the export file.
d. Save the export file to the location you specified by clicking the Export button.
e. Click OK to close the window confirming a successful export.
f. RoadSoft creates two files in the location you specified:
   - RStoLDC_[jurisdiction]_[date]_[time].ldcz
   - RStoLDC_[jurisdiction]_[date]_[time].zip

For the purposes of 50% network reporting, you will be sending the .zip file to TAMC
g. Copy the .ldcz file to a CD, flash drive, or other portable storage device so you can transfer it onto the laptop that has the LDC software installed on it.

---

**Step 3: Send a copy of the TMC network to the CSS**

Your agency should submit a copy of the exported TMC network to the CSS before beginning data collection.

b. Click the Investment Reporting tab at the top of the page and select Data.
c. Log in using your user ID and password.
d. Select the Send Data sub-tab.
e. Choose the Other File button
f. Select your jurisdiction from the dropdown menu.
g. Click the **Choose file** button to attach the `.zip file` you created in Step 2.

h. Click the **Upload** button to submit the data to the TAMC.

---

**Step 4: Import the Network into the LDC**

a. Insert the portable storage device that contains the export file from the local agency.

b. Start the LDC software. You will be prompted to select a database (DB) and crew name.

c. Click the **button** to locate the export file on the portable storage device.

![Login Form]

**NOTE:** If you want to change your database while inside the LDC, select the **File** menu, then click **Change DB (Import Data from RoadSoft)**.
Step 5: Connect the GPS to your laptop and begin collecting data

To Connect the GPS:
- Start the LDC software.
- With your GPS device turned off, connect it to your laptop using the Serial or USB connection.

**NOTE:** If your GPS is on before connecting it, your mouse pointer may jump around erratically. If this happens, turn off your GPS, leave it connected, and restart windows and the LDC.
- Turn on your GPS and wait for it to acquire a position (this could take a couple of minutes).
- From the LDC main menu open the GPS menu and select Connect to establish communication between the GPS and the LDC software. Wait a few minutes for the software to snap to the GPS position on the GIS map. If your GPS fails to connect, wait several minutes and try to connect again, or contact RoadSoft Support.

**NOTE:** If you’re not on or near a road segment that is part of the network that you imported into the LDC software, the software will not be able to snap to a segment on the map. Drive your vehicle toward a road that is part of the network so that the vehicle marker can snap to it. If this does not happen, restart the LDC or call RoadSoft Support.

To Collect Data:
- Use the following shortcut keys to enter data into the LDC software:
  - Ctrl + S  Surface Type
  - Ctrl + 0–9  PASER Rating
  - Shift + Ctrl + 0–9 Number of Lanes
  - Ctrl + Enter  Submit (save) Data
  - Ctrl + +/-  Zoom In/Out
  - Ctrl + Arrow Keys  Pan the GIS Map
  - Ctrl + Space Bar  Hold/Release Segment

For a complete list of shortcut keys, open the Help menu and select Shortcut Keys.

**IMPORTANT:** While collecting data, back up every hour or as often as conveniently possible. From the main LDC menu select the File menu, then Backup Database to back up your data. If data collection spans multiple days, export the data every day and save a copy of the data file (LDCtoRS_ [date] _[time].ldc2rs) to a CD, jump drive, or floppy disk.
TIP: The History tab provides a history of PASER ratings for the current segment. Viewing past PASER ratings before rating a segment can influence the rating. To avoid possibly influencing the current rating based on past ratings, this grid will not be visible until you submit a rating for the segment.

e. To complete the data collection process, verify that there are no unrated roads in your TAMC network: To do so: click on the File menu.

f. Select Current DB Statistics and verify that the Total Miles Not Yet Rated field displays 0. If the field does not display zero, then check which segments still need to be rated within your network using the LDC.

g. Proceed to Step 6 once all the roads in your TAMC network are rated.

Step 6: Export collected data from the LDC

a. From the LDC main menu, select the File menu, then Export DB/Data to RoadSoft.

b. In the Export Path field, enter a location on your hard drive to save the export file. Click the button to browse your hard drive.

c. Click the OK button once the Export Complete notice displays.

d. Copy the “LDCtoRS_[jurisdiction]_[date]_[time].ldc2rs” file to a portable storage device.

IMPORTANT: The “LDCtoRS_[jurisdiction]_[date]_[time].ldc2rs” file contains a great deal of information that could be useful for emergency data recovery purposes. The RoadSoft team strongly recommends that you save a copy of the file in a permanent archive every day to facilitate data recovery.
Step 7: Import the collected data to RoadSoft

**IMPORTANT:** Before you import new data into RoadSoft, backup your existing RoadSoft database. To do so, select the **Tools** menu, then **Run Database Manager** from the RoadSoft main menu. RoadSoft has to shut down to run the Database Manager. You can restart RoadSoft after backing up the data.

a. In the main RoadSoft window, open the **TAMC** menu and select **2 - (County/City Does This) Import TAMC PASER Data from LDC.**

![Image of Import LDC Data window]

It is highly recommended that you perform a Roadsoft Data Backup prior to importing LDC data.

Do you wish to do a backup prior to importing?  
- Yes  
- No  
- Cancel

b. If you haven’t already backed up your RoadSoft data, click the **Yes** button to open the RoadSoft Database Manager and create a backup, then proceed with importing your collected data. If you already backed up your data, click the **No** button to continue with the import.

c. In the **Import Data from LDC** window, click the **Browse For LDC Export** button, and then locate the “LDCtoRS_ [date].ldc2rs” file. When the import process is completed, RoadSoft will automatically restart.

![Image of Import Data From LDC window]
Step 8: Export RoadSoft asset management data for the regional version of RoadSoft

a. In the main RoadSoft window, open the TAMC menu and select 3 - (County/City Does This) Export TAMC PASER Data to Region.

b. In the Export Path field, enter a location on your hard drive to save the export file. Click the button to browse your hard drive.

c. Click OK when your export has been completed successfully.

d. RoadSoft creates a file named “TAMC_[jurisdiction]_[date]_[time].tamz” in the location you specified. Copy this file to a portable storage device for import into the Region’s version of RoadSoft.

Step 9: Import RoadSoft asset management data from the local agency into the regional version of RoadSoft

NOTE: This step is not performed in the field; it should be performed at the regional office to import inspection data from individual agencies.

IMPORTANT: Before you import new data into RoadSoft, backup your existing RoadSoft database. To do so, open the Tools menu and select Run Database Manager from the RoadSoft main menu. RoadSoft has to shut down to run the database manager. You can restart RoadSoft after backing up the data.

a. In the main RoadSoft window, open the TAMC menu and select 4 - (Region Does This) Import TAMC PASER from County/City.
b. If you haven’t already backed up your RoadSoft data, click the **Yes** button to open the RoadSoft Database Manager and create a backup, then proceed with importing your collected data. If you already backed up your data, click the **No** button to continue with the import.

c. In the *Import Data from LDC* window, click the **Browse For File to Import** button, and then locate the “TAMC_[Jurisdiction]_[date].tamz” file. When the import process is completed, RoadSoft will automatically restart.

![Import TMC Data From Local Jurisdiction](image)

**NOTE:** The *Import RoadSoft Data* screen lists the last four folders that you imported from. If this is the first time you’re importing data, the screen will appear blank as above.

**Step 10: Export shape file and submit to the TMC**

**NOTE:** Once your regional data is complete, export the regional shape file to the CSS.

- To verify your regional data before proceeding, follow the steps in Section 5.
- In the main RoadSoft window, open the TMC menu and select 5 - (Region Does This) Export TAMC Shape File to Council (Individual County Files).

**NOTE:** Do **NOT** use the standard RoadSoft Shapefile Export, that export is different than the TMC export.
c. Select the County you wish to export using the drop-down menu in the **Export County** field.

d. In the **Save Export Data to** field, enter the name of the county you are exporting.

e. In the **Shapefile Name** field, enter the name of the county you are exporting local road data for.

f. Click the **Export** button to export the data to a location on your hard drive.

g. Follow the guidelines in **Step 3** to upload the exported file to TAMC to the CSS Investment Reporting Tool (IRT). However, in this case you must choose the **PASER Data** button rather than **Other File** button in Step 3-g.
Section 3: Sealcoat Road Rating Guide

The Rating System

The PASER rating system rates a sealcoat road (sealcoat over a gravel base) on a scale of 1 to 5. However, the TAMC has decided to adopt a modified version of this rating system based on a 1 - 10 scale. This standardizes ratings so that all surface types in your TAMC network are rated on the same scale. The Michigan PASER Sealcoat scale is based on the relative percent of distress observed in the pavement.

Using the “Percentage” Approach

Sealcoat PASER ratings are based on the percentage of distress over a cross section of the total length of the segment under consideration.

The distresses are:

- edge distress
- lane distress (including rutting)
- raveling

These percentages are not cumulative.

Consider a cross section of the roadway segment; it can be 50 ft. long or 1 mile long. If neither of the surface distress percentages outlined in the sealcoat rating chart exceed the upper limit of a rating description, then that rating is your selection.

As another example: A PASER sealcoat rating of 5 allows up to 20% raveling, 20% edge distress or 20% lane distress. If your assessment yields 10% raveling, 5% edge distress and 20% lane distress, the PASER rating is 5 because neither of the distresses exceeds 20%. It is not a PASER rating of 6 because lane distress exceeds the 10% criteria, and it is not a PASER rating of 4 regardless that the cumulative total distress equals 30%.

Consult the table on the following page for specific rating criteria.
<table>
<thead>
<tr>
<th>PASER Rating</th>
<th>Description</th>
<th>Condition / Defects</th>
<th>Remedy / Action</th>
<th>Typical Age in years *</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Excellent</td>
<td>New construction</td>
<td>None</td>
<td>&lt; 1 year</td>
</tr>
<tr>
<td>9</td>
<td>Excellent</td>
<td>Like new</td>
<td>None</td>
<td>1 to 3</td>
</tr>
<tr>
<td>8</td>
<td>Very Good</td>
<td>First signs of distress</td>
<td>Routine maintenance.</td>
<td>3 to 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Limited edge distress</td>
<td>Minor edge seal</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Good</td>
<td>Minor distress</td>
<td>Minor asphalt or spray-injection patching</td>
<td>4 to 6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Edge distress with limited lane distress &lt;5%</td>
<td>Possible single application sealcoat</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Raveling &lt; 5%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Good</td>
<td>Moderate distress</td>
<td>Moderate asphalt or spray-injection patching</td>
<td>5 to 7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Edge distress up to 10%</td>
<td>Single application sealcoat</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lane distress up to 10%</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Raveling up to 10%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Fair</td>
<td>Distressed</td>
<td>Moderate asphalt or spray-injection patching</td>
<td>6 to 8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Edge distress up to 20%</td>
<td>Single application sealcoat</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lane distress up to 20%</td>
<td>With up to 50% double application sealcoat</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Raveling up to 20%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Fair</td>
<td>Edge distress up to 30%</td>
<td>Asphalt or spray-injection patching and Double application sealcoat</td>
<td>7 to 9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lane distress up to 30%</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Rutting of ½” to 1”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Poor</td>
<td>Edge distress up to 50%</td>
<td>Wedge and/or asphalt or spray-injection patching and Double or Triple application sealcoat.</td>
<td>8 to 10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lane distress up to 50%</td>
<td>May be necessary to crush and reshape prior to new sealcoat surface</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Rutting of 1” to 2”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Very poor</td>
<td>Edge distress &gt; 50%</td>
<td>Reconstruct by crush and shape prior to new sealcoat surface, possible return to gravel</td>
<td>&gt; 9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lane distress &gt; 50%</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Rutting greater than 2”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Failed</td>
<td>Extensive distress</td>
<td>Reconstruct by crush and shape prior to new sealcoat surface, or return to gravel</td>
<td>&gt;10</td>
</tr>
<tr>
<td>0</td>
<td>Not Rated</td>
<td>&gt; 50% of surface area</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Section 4: Splitting Segments

Segment Splits
The RoadSoft map initially splits all street and road segments on an intersection-to-intersection basis (node to node) or by using Act 51 boundaries (township/city/county). Users can add road segment splits to denote changes in surface types or conditions.

Rating teams should respect segment splits previously created by local agencies within RoadSoft. The following sub-sections on splitting segments will help you decide if introducing new splits is warranted, and how to introduce those new splits if necessary while collecting TAMC data.

Guiding Principle for Splitting Segments

- If the area in question has received rehabilitation or reconstruction separate from the Framework segment from which it came, then the segment in question should be split from the framework segment into its own designated rating segment.
- Avoid splitting segments into lengths of less than ¼ mile.

Good Reasons for Splitting Segments

Change in Surface Type
If the road surface changes from asphalt to gravel, asphalt to chip seal, chip seal to gravel, etc., then splitting a segment to reflect that change in surface type can ensure that the inventory collected is representative of the actual road conditions.

Number of Lanes
Commercial or development activity may require the addition of through lanes or continuous left turn lanes within a given framework segment. Splitting a segment to reflect this change will ensure that RoadSoft’s lane mileage inventory reflects the true mileage accurately.

Intersection as a Unique Facility
Many intersections within a County/City system are extensions of segments, meaning their design, surface type, service life, and number of lanes are no different than the segment they stem from. However, some intersections have significant changes in surface type and/or geometry. In these cases, it may be best to designate the intersection as a unique facility by making it a distinct segment.

Environmental Factors
Environmental factors can have a significant impact on a segment of road. For example, regular flooding or exceptional frost heave can cause severe damage to the roadway. Although this type of deterioration is rare, if they are longer than a ¼ of a mile they should be designated as their own segment so as to isolate the area needing rehabilitation or reconstruction.
Bad Reasons for Splitting Segments

The following cases do not affect the network as a whole, and therefore do not warrant segment splitting:

- Change in PASER rating over a short stretch (Example 50 feet)
- Short right or left turn bay
- School zone
- Traffic count segments
Section 5: PASER Data Quality Control Guide

Verifying PASER Data

It is important to ensure that your PASER data is accurate and comprehensive. It is easiest to check for errors in data at the local and regional levels before submitting data to the TAMC. Data quality control can be performed by entering a series of queries into the Network/Filter Builder in RoadSoft. The following steps will guide you through this process and ensure that your agency has a complete set of PASER data.

STEP 1: Determine the Total Length of Your Network

a. Open the Network/Filter Builder either by right-clicking on the map and selecting Network/Filter Builder, or by clicking on the map toolbar’s Filter button and selecting Network/Filter Builder.

b. In the Network/Filter Builder window, click the Open button to open the Select Network/Filter window.

c. Select your saved TAMC network for the current collection year and click the OK button.

d. Look at the bottom left of the Network/Filter Builder window. Record the number of Segments Found and the total length of those segments in Miles. You will use these numbers, along with additional criteria, to verify that your regional PASER data is correct.

STEP 2: Verify that Your Agency’s TAMC Data is Accurate

Using the filter criteria provided in the Table of Quality Control Queries (next page), you will be able to detect missing or incorrect data by comparing the Segments Found and Miles in a particular query against your original Segments Found and Miles (generated in Step 1 above).

In the Table of Quality Control Queries:

- **Check** lists the potential error that the criteria checks for
- **Criteria** lists the criteria that need to entered into the network and filter builder
- **Expected Output** lists the segments/mileage that should display at the bottom left of the Network/Filter Builder after adding the criteria
- **Troubleshooting** lists the most likely reason for not getting the expected outcome and steps to take to fix/obtain any inaccurate/missing data.
### Table of Quality Control Queries

Ensure you have recorded the Segments Found/Miles within your TAMC network (see step 1 above) before you use the following Table of Quality Control Queries. Used in combination with these queries, those figures will help you verify the data you collected for the TAMC is accurate and complete.

<table>
<thead>
<tr>
<th>Check</th>
<th>Criteria</th>
<th>Expected Output</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| Check that all segments/mileage in the TAMC network have been rated | TAMC Collection Year = *current year*  
Latest Eval Year = *current year* | the number of Segments Found/Miles recorded in step 1 | If the Segments Found/Miles are not the same as those recorded from your TAMC network in step 1, then there are segments that did not receive a rating. Missing rating data must be collected. |
| Check to see if all submitted segments have a valid surface type | TAMC Collection Year = *current year*  
Latest Eval Year = *current year*  
**Surface Type** = Asphalt, Concrete, Seal Coat, Brick | the number of Segments Found/Miles recorded in step 1 | If the Segments Found/Miles are not the same as those recorded from your TAMC network in step 1, then there are unpaved or undefined roads in the network. Verify that these segment types are correct. |
| Check to see if all submitted segments have a valid surface rating | TAMC Collection Year = *current year*  
Latest Eval Year = *current year*  
Latest Surface Rating >= 1 - Failed | the number of Segments Found/Miles recorded in step 1 | If the Segments Found/Miles are not the same as those recorded from your TAMC network in step 1, then there are segments that have an invalid rating. These segments should be reviewed and rated. |
| Check to see if all submitted segments have a valid number of lanes | TAMC Collection Year = *current year*  
Latest Eval Year = *current year*  
**Number of Lanes** <= The highest number of lanes within your TAMC network  
*A unusually high number of lanes in the drop down list could signify an error in entry* | the number of Segments Found/Miles recorded in step 1 | If the Segments Found/Miles are not the same as those recorded from your TAMC network in step 1, then there are segments that have an invalid number of lanes. Segments with invalid lanes should be reviewed and corrected. |
Appendix A: Data Collection Timesheet
This form is an example. Please obtain appropriate Time Expense Logs from your RPO/MPO.

**TRANSPORTATION ASSET MANAGEMENT COUNCIL**
DATA COLLECTION - ROAD INVENTORY LOG

| CREW INFO: Please insert the names of the crew. | Date: __________________________ |
| M-DOT Region - | Hours/Minutes Worked: __________________ |
| Planning Region - | |
| County - | |
| City - | |

Please check the following work type:

- OFFICE WORK: [ ]
- FIELD WORK: [ ]

GEOGRAPHIC AREA: Please insert region, county, township, city, etc.

**MILEAGE LOG:**

| VEHICLE: | General Comments: |
| BEGIN MILE: | |
| END MILE: | |
| TOTAL: | |

TOTAL MILES OF FED-AID ELIGIBLE ROADS INVENTORIED: __________________________

Please fill out this form each day you perform asset management tasks. E-mail to chesbrog@michigan.gov. If you have any questions, please contact Gil Chesbro at 517-335-2963 (office) or 517-242-3535 (cell)
Appendix B: Data Collection Timesheet

Asset Management Change Request for Michigan Geographic Framework

All boxes must be completed

Map Reference Number: __________  Date Observed: / / 
Contact Information  Agency: __________
Contact Name: ____________________  
Phone Number: ( )  EMAIL: ____________________

Is the Observer the same person as the Contact person? If no:

Observers Name: ____________________  Agency: ____________________
Phone Number: ( )  EMAIL: ____________________

Location Information
County: ____________________  Township/City/Village: ____________________
Street Name: ____________________  PR 1: ____________________
Cross Street 1: ____________________  PR 2: ____________________
Cross Street 2: ____________________

Who has jurisdiction of this road?

What kind of Change? (Please Check One)
☐ Intersection Reconfiguration  ☐ Road Addition  ☐ Road Removal
☐ Road Interruption: IF YES, what is the cause?
☐ Other, please explain (use back for more space):

What year did this change occur?

Make additional copies as needed
Revised Date: June 2, 2005

Please send completed forms and reference map to: CGI, Attn: Laura Bialetic
Romney Building - 10th floor, 111 S. Capitol Ave., Lansing, MI 48913 (517) 373-7910